Question

Are Swar Systems
products compatible with
Windows Vista?

Product

All

Type

Compatibility

Resolution
Yes, all our products are Vista compatible.

However some users, who are running Vista with Service Pack 1, might experience some audio re lated problem with
SwarShala. Practice and Compose Panels may not produce sound. This is not due to SwarShala, but due to a bug in Vista
Service Pack 1.

«  Uninstall Vista SP1 through Control Panel. In some cases, uninstalling Vista SP1, solved the problem. If this doesn't
solve the problem then read further.

»  You should check if Vista compatible drivers are available for your sound card. If not then check with your sound card
manufacturer if they have released any Vista compatible drivers for your sound card. Install Vista compatible drivers
for your sound cards and check if you get the sound.

« If you still don't get any sound when playing Practice or Compose pane, then you'll need to apply a patch from
Microsoft that should fix the problem. For that, you will first need to login under the “Administrator” user profile. If
you don't see such a profile at startup, then it's probably hidden (by default). Here are the steps to activate it:

1. Log on Vista using your normal username (and password, if needed).

2. Click on the Start button.

3. Click on Start Search.

4. Type, cmd.

5. Right-click on the cmd option and select 'Run as administrator' from the shortcut menu.

6. In the black 'DOS box', type the following at the command line: Net help user

7. The idea of the last command is just to observe the options for Net User. In particular, examine the syntax
to set the password.

8. The next instruction is the crucial command.

Type: Net user administrator password

10. Type: Net user administrator /active:yes

11. Check the message: The command completed successfully

12. Switch User, or logoff

13. Logon as “Administrator” using the password you entered in step 9

Once you are logged as “Administrator”, you can download and run the actual fix from Microsoft. For that, download
the self-extracting archive (see below), save it on your hard disk and then run it. This will extract the patch installer




into the folder you'll specify. Once done, run this patch installer, following the instructions, then restart your system
and log under your normal user: you should then hear proper sound in SwarShala’s Practice and Compose panes.

PATCH FOR WINDOWS 32 bits
Self-extracting archive : www.swarsystems.com/Downloads/dxfix.exe
Password to unlock it : ywQ400GP9

PATCH FOR WINDOWS 64 bits
Self-extracting archive : www.swarsystems.com/Downloads/dxfix64.exe
Password to unlock it : W$_3q[pck_

Can I use my SwarShala Compatibility | You can export your components/compositions from SwarShala as .wav (AIFF on Mac) or MIDI files. These files can then be
rhythmic/melodic patterns used in other sequencers. You can do this by using 'Export as' option from File menu. Also note that dragging a component
created by SwarShala in out of SwarShala on a folder or a MIDI track will automatically export there a MIDI file of the component.

other applications like

CakeWalk, Nuendo,

Cubase, ACID etc?

Is SwarShala Standard SwarShala Compatibility | Yes, from version 3.1.1 SwarShala Standard is now available on Mac OS X (both PPC and Intel).

compatible with Mac?

I have Windows Vista SwarShala Compatibility | It does work on Vista 64. Only the AstSrv.exe program needs to be moved from Windows/system32 to Windows/system64.
64bits. Will SwarShala run

on that?

I have SwarShala. Can I SwarShala Compatibility | SwarShala is a standalone software and doesn’t support external MIDI devices. If you want to play the Swar Systems

play it using my MIDI instruments using your MIDI keyboard, you need SwarPlug or SwarTrax. These products add our collection of instruments to
keyboard? your sequencer and/or sampler.

My operating system is SwarShala Compatibilty | Check out the “Are Swar Systems products compatible with Windows Vista?” Section.

Windows Vista. I can't Swar Librarian

hear anything in

SwarShala’s

Practice/Compose panes.

I want Indian instruments SwarPlug Compatibility | If you are planning to do most of your composition work in a software sequencer like LogicStudio, Cubase, Neundo,

in Garageband. Which
product is suitable for me?

FruityLoops, GarageBand etc..., then SwarPlug will be the product of choice. SwarPlug is a VST/Audio Units plugin that works
perfectly with all the VSTi/AU compatible sequencers.



http://www.swarsystems.com/Downloads/dxfix.exe
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Once you have that installed, you can open a MIDI track in Garageband (or another sequencer), assign SwarPlug to that track
and then use your external MIDI keyboard for playing the Indian instruments selected in SwarPlug, or use the thousands of
MIDI loops that come with the Librarian.

Will SwarPlug work with SwarPlug Compatibility | Yes, SwarPlug works perfectly with ACID.

ACID?

I use CakeWalk as my SwarPlug Compatibility | SwarPlug would be a really useful tool for you. Though CakeWalk doesn’t support VSTi or AU plugins natively, you can still

main sequencer and am use SwarPlug with it through a VSTi to DXi adapter. Lots of our clients are using SwarPlug successfully that way.

missing some Indian

instruments in it. Which of This wrapper is now included in recent versions of CakeWalk, or you can purchase it from their site if you have an older

your products is version.

compatible with

CakeWalk?

I am using ProTools as my SwarPlug Compatibility | Check the “Can I use SwarPlug with ProTools?” section.

main DAW. Can I use

SwarPlug with ProTools?

Can I use SwarPlug with SwarPlug Compatibility | swarPlug is a VSTi/Audio Units plugin, while ProTools has its own proprietary plugin protocol called RTAS and does not

ProTools? support VSTi/AU standards natively. However, you can still use SwarPlug or any other VSTi plugins through a VSTi-RTAS
wrapper like the one available at fxpansion.com. Lots of clients are using it successfully with SwarPlug.

Can I use SwarPlug with SwarPlug Compatibility | SwarPlug works perfectly with LogicStudio and all other VSTi/Audio Units compatible sequencers including Garageband,

LogicStudio? Cubase, FruityLoops, Acid, Digital Performer, Adobe Audition etc...

I use M-audio session SwarPlug Compatibility | SwarPlug and SwarTrax come with over 2000 pre-made patterns. You can listen to these sequences using Swar Librarian that

software for simple SwarTrax is installed with SwarTrax and SwarPlug both. You can drag these loops from Swar Librarian window, on to your sequencer or

compositions and any folder as MIDI files. You can then route these loops through SwarPlug or SwarTrax patches loaded on a software

Steinberg Cubase for more sampler. SwarTrax/SwarPlug don't contain .wav loops. To generate that, you can go for SwarShala Pro.

complicated compositions.

Does your software have

midi/wav loops available?

Is SwarPlug/SwarTrax SwarPlug Compatibility | swarPlug is not Java based nor is SwarTrax. Though both come with Swar Librarian, which is a small utility that helps you go

java based? How does a SwarTrax

java software run in

through the included collection of MIDI loops. Swar Librarian runs on Java Runtime Environment platform.




Cubase?

Is Acid Pro 6.0 a suitable SwarPlug Compatibility | ACID supports VST plugins so SwarPlug will be a good choice.

sequencer? Should I SwarTrax

go for SwarTrax or

SwarPlug?

Is any of your products SwarPlug Compatibility | By default, M3 comes with 64 MB of internal RAM only, which means that you can only load a limited number of instruments.

compatible with KORG SwarTrax Also the sample data in RAM memory is not backed up when the power is turned off. If you wish to keep this data, you must

M3? I want to load Indian save it onto a media before turning off the power. Samples can be loaded from SwarPlug or SwarTrax through a USB key and

instruments on M3. then mapped one after the other using the key ranges specified in our Mappings document.

However, you can also go for the additional EXB-M256 card that will give you an additional 256 MB RAM and will also allow
you to import Akai S2000/3000, SoundFont patches. You'll also be able to save the samples directly on that card.

I work on MOTIF and SwarTrax Compatibility | If you are planning to do most of your composition work on MOTIF, we would recommend SwarTrax MOTIF version.

want to load Indian SwarTrax normally comes with Akai patches of Indian instruments, but you can get MOTIF patches on demand. It also comes

instruments sounds on it. with thousands of MIDI loops and a Librarian software to browse them.

What's the best product

for me?

I have Roland Phantom-G. SwarTrax Compatibility | It seems that Phantom can only load individual .Wav files and not the full Akai patches. In this case, you can import individual

I would like to download stroke files manually and create your own patch. For the exact procedure you'll have to consult your Phantom manual.

patches of Indian SwarTrax can give you individual .wav samples of Indian instruments. For example you can load individual Tabla samples (tin,

instruments and also MIDI na, dha, dhin...), respecting the key ranges specified in our Mappings document, on your Phantom and thus create your own
files to play Hindi music. patch.

Will SwarTrax help me? If you want to load the entire patch in one go, you must have a sampler keyboard that can load Akai patches. Keyboards like
Triton, M3 can load Akai patches in one shot. If you have such a keyboard you can use SwarTrax Akai Cd's for loading Indian
instruments patches on your keyboard.

I use a Korg PA2X-Pro. SwarTrax Compatibility | PA2X-Pro is a sampler keyboard that can import .wav, .aiff and also Akai patches. For loading Indian instruments (Swar

Can I load Swar Systems Systems’ Indian instruments patches) on your keyboard, you can use SwarTrax, which comes with Akai patches of 74 Indian

Indian instruments on my instruments. For the exact loading procedure, you'll have to go through your keyboard’s manual or consult KORG. Normally

keyboard? musicians connect external CD ROM's to the keyboard for loading Akai patches on the keyboard. Some keyboards also have a
USB port for connecting external USB CD drives. For the exact process of loading Akai patches from a Akai CD-ROM, you'll
have to consult PA2X-Pro’s manual.

Iintend to buy a All Features There is one common thing across all the products, i.e. the instruments patches and the ready made patterns/loops.




software/plugin that would
allow me to import ready-
made percussion
grooves/loops/phrases etc
onto my MIDI or audio
track. Which is the best
product for me?

SwarPlug is a VST/Audio Units plugin that works with all the VST/AU compatible sequencers like LogicStudio, Cubase,
Neundo, FruityLoops, ACID etc. SwarPlug Xtra edition comes with 74 Indian instruments patches.

If you are using an Akai compatible software sampler like Kontakt, Sample Tank, EXS24 you can also go for SwarTrax Akai
version. SwarTrax Akai gives you all Swar Systems Indian instruments patches in Akai format. Other formats like NN-XT (for
Reason), MOTIF (for MOTIF keyboards) are also available on demand. You can use SwarTrax Akai with sampler keyboards
and hardware samplers also.

Both SwarPlug and SwarTrax come with a Swar Librarian software that contains more than 2500 loops on different
instruments. If you like a pattern, you can simply drag it to your sequencer. For example if you are using Cubase, you can
drag the pattern from Swar Librarian window on to your Cubase tracks view as a MIDI sequence. You can route it through
SwarPlug or SwarTrax loaded with appropriate patch.

SwarShala on the other hand is a standalone software. It doesn't connect to external MIDI devices. It's a very good tool to
learn about Indian music, for Practicing with Indian instruments and also for composing. It comes with over 2500 ready made
patterns and sequencers that can be easily customized to your needs, or which you can create from scratch. You can then
export these sequences as MIDI or Wav files to use them in your sequencers afterwards or create complete multi-track
compositions within SwarShala itself.

Are the number of SwarShala Features SwarShala Standard comes with only Tabla, Tanpura, Harmonium and Manjeera, while the Xtra edition comes with 74 Indian

patterns available in instruments. This means, that SwarShala Standard comes with a limited set of loops and patterns. However Tabla, Tanpura,

SwarShala Standard and Harmonium and Manjeera patterns are both same in SwarShala Pro and SwarShala Standard.

SwarShala Pro Xtra edition

same?

Will I get a fully activated SwarShala Features Yes, SwarShala Standard has all Practice Panel features but limited Compose panel features.

Practice Pane with

SwarShala Standard

version?

How can I create a new SwarShala Features You can start a new composition by selecting 'New Composition' option from File menu, or clicking the new composition

composition? button available on compose tool bar. You can then add tracks to your composition by selecting Add Track option from Tracks
Menu, or clicking the Add Track button E available on compose toolbar

How do I force a echoing SwarShala Features You can do that by adding a “Mute” stroke. For that, click on the Cell you want to mute, select the Properties button, select

note to stop?

the stroke to mute, select the “Mute” value in the Style drop-down list (or type it exactly that way, if missing) and then press
Apply.




Is there any limit in length SwarShala Features No, there is no such limit. Just a longer composition will take longer to “prepare” at the time of playback.

to a composition?

What is a component? SwarShala Features A component is a rhythmic/melodic sequence that can be reused within a composition or within another component.
Components are available in the Compose pane, Sequence view. User can select any instrument supported by SwarShala
through the Instruments drop-down list. Selecting a particular instrument (base) displays all the components available in that
base.

By default most instrument bases are loaded when you start the software, as we are including them in the Autoload field of
the Preferences screen. However, if an instrument is missing, or you wish to load a specific base from another folder, you can
do so through the File | Open Base option, browsing for the corresponding .ssb file.

What is the use of volume SwarShala Features With the help of volume envelope you can set volume variations for various parts of your sequence, by defining points of a

envelope? virtual curve along which volume fluctuates.

In a composition, volume envelopes can be set for every component separately. Volume Envelope definition dialog can be
accessed from Components | Set Volume Envelope menu option.

What do I do with the SwarShala Features Practice Pane is a very helpful tool for vocalists, percussionists and instrumentalists who require rhythmic, tanpura and/or

Practice Pane? lehra accompaniment for their practice. So, whether you want help in your riyaaz or simply want to jam along virtual Indian
musicians, Practice pane is there for you!

I have bought SwarShala. SwarShala Features SwarShala is a standalone software and doesn'’t support external MIDI devices. If you want to use your external MIDI devices

Can I use the keys on my for playing Swar Systems Indian instruments then you can go for SwarPlug. SwarPlug is a VST/Audio Units plugin that works

piano to play the all the VST/AU compatible applications like LogicStudio, FruityLoops, Cubase, Nuendo, ACID, Garageband etc. You can assign

instruments in SwarShala? SwarPlug to a MIDI track and then play SwarPlug Indian instruments using your external MIDI keyboard.

Is there any program or

software I can use to do

this?

Is SwarPlug multi-timbral? SwarPlug Features SwarPlug is not a multi-timbral plug-in but depending upon your sequencers capability, you can open as many instances of

If not, how many SwarPlug as required.

instances of the plugin can

I open?

How can I access the SwarPlug Features You can go thorugh all the sequences and patterns that come with SwarPlug/SwarTrax using SwarLibrarian. If you like a

MIDI loops that come with
SwarPlug/SwarTrax.

pattern, you can simply drag it to any folder or your sequencer as a MIDI file.




Can I create patterns in Swar Librarian Features Swarlibrarian is a small utility that lets you go through the included collection of loops and patterns that come with

Swar Librarian? SwarPlug/SwarTrax to try them. If you like a loop, you can then simply drag it on your sequencer as a MIDI sequence, where
some editing is possible within your MIDI editor. If you want an easier way of creating custom loops and then drag&dropping
them as MIDI files, you can check out SwarShala.

How do I copy patterns Swar Librarian Features Its very simple. Once you decide which loops to use, you can simply drag them on a MIDI track of your sequencer.

from Librarian to my

sequencer?

I want to know if I can Swar Librarian Features Swar Librarian is just an audition tool that lets you listen to all the patterns and sequences that come with SwarTrax and

create my own loops in SwarPlug. There aren't any editing features there. If you like a pattern in Swar Librarian, you can simply drag it to your

Swar Librarian. I see cut, sequencer window as a MIDI file.

paste and a window at the

bottom. But I am unable If you want to create custom loops and drag&drop them to your sequencer as MIDI or wave files, then you can check out

to do anything with these SwarShala as well.

buttons.

If I drag and drop the Swar Librarian Features These loops will be MIDI loops.

loops from the Swar

Librarian to Logic Studio,

These loops are

MIDI/WAV?

How long will SwarShala SwarShala Demo SwarShala demo runs for 14 days only, there is no license code required for demo version.

demo work? is there any

license key required for

demo?

I ordered a packaged All Ordering It usually takes 2 to 4 days for a package to reach a destination in India or Europe. Count 4 to 7 days for other destinations.

version. When can I

expect the package?

How much do I have to All Ordering For international clients, the shipping cost is fixed at $25. For Indian clients, the prices may vary depending upon the location.

pay towards packaging
and shipping if I order a

Indian customers can send a mail to sales-india@swarsystems.com and we'll confirm the shipping cost.



mailto:sales-india@swarsystems.com

packaged version?

How can I check the All Ordering You can download a Demo version of SwarShala. It comes with 14 days trial. Demo version consists of 3 instruments — Tabla,
software before buying it? Harmonium and Tanpura.
We do not have a demo version of SwarPlug at the moment, but you can check out a small audio clip of each of our
instruments at www.swarsystems.com/Instruments. SwarPlug works with most VSTi/AU sequencers. Just let us know the
model you are using and we'll be able to confirm whether we have tested it or not.
Would I be able to All Ordering Yes, if you have opted for download version, you will get the download instructions instantly on your registered email as soon
download as soon as I as your payment is received. All our online, credit card transactions go through PayPal, which is a very secure medium. If you
pay? What is the most are not comfortable paying by credit card, you can also wire transfer money into our bank account, or even send us a
secure and fastest way to Western Union money transfer. You can contact us at support@swarsystems.com to discuss with our support team regarding
get the software? the best payment method for you.
Download instructions for downloading the software are sent immediately after your payment is received, whether you order
a packaged or downloadable version.
Downloadable version has the same content as packaged one. But if you would like to have the CD and printed manual, or if
you can’t download 200 to 400 MB, then you can go for the packaged version, which comes for additional $25, shipment
included. Just note that some taxes/customs may apply at the time you receive the parcel.
I want your product All Ordering Yes, you will get the download instructions instantly on your registered email as soon as your payment is received, whether
immediately. Can I you order a downloadable version or a packaged one.
download it immediately
after the payment?
I lost my All Ordering If you are a registered user, you can order a replacement CD from our online shop at http://www.swarsystems.com/shop for
SwarShala/SwarPlug CD. $1 + $25 shipping fees. If you are not yet registered, just send an email at registration@swarsystems.com giving your
How can I get it again? personal details, Serial Nr and Product Key that came with the package and retailer from whom you purchased it.
Indian customers can contact us directly at sales-india@swarsystems.com.
I don't want to pay All Ordering Feel free to email us at sales@swarsystems.com and we'll propose you some other options like a bank account

through PayPal/a credit
card. What other options
are available?

deposit/transfer or a Western Union draft.

If you don't want to pay using your credit card, you can send us a mail at sales@swarsystems.com and we'll assist you for
other payment options.
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Also Indian customers can directly contact us at sales-india@swarsystems.com for special Indian prices.

What are the payment All Ordering If you live in India, you have the following payment options:
options for Indians?
a) Drop a cheque in the name of ‘Swar Systems India’ at your nearest ICICI Bank or ATM.
b) Deposit cash at your nearest ICICI Bank branch.
c) Pay using your credit card. For that you'll have to send us an e-mail at support@swarsystems.com and confirm your
order. We'll then get back to you with proper instructions and a payment link.
Swar Systems India account details are here below:
Account Name: Swar Systems India
Account No: 025005001196
Bank: ICICI Bank, Dwarka Branch
I am trying to install All Installation | This usually happens when files that need to be overwritten by the installer are locked, for example by a running instance of
SwarShala/SwarPlug from SwarShala. To avoid this, close all applications on your computer, reboot, and then only launch the installer.
the CD. It goes up to 50%
and then stops displaying If this doesn't solve the problem, then you may have a corrupted or damaged CD. You can either order a replacement CD
some ‘data move’ error. from our website or you can directly mail to support@swarsystems.com so we'll send you the download instructions.
What should I do?
I have the SwarPlug CD All Installation | May be your CD is corrupted or you don't have a proper StuffIT expander program. Try copying the .sit file to your hard disk.
but I can't open the .sit If it's still not working then download StuffIT Expander. StuffIT Expander extracts .sit file contents.
file to install SwarPlug in
my Mac. Please let me The more recent versions of SwarPlug come as a .zip file or directly the installer at the root of the SwarPlug CD.
know how to install it?
If I have SwarShala pro SwarShala Installation | Since you have an Xtra edition, you can choose any one of the options. It just installs a specific set of practice sessions, which

3.0.11 Xtra Edition, which
option do I choose in the
setup? Do I have to
uncheck both Hindustani
and Carnatic? Or do I
choose only Hindustani?
There's no option of
checking both Carnatic
and Hindustani.

you can change anyway later on. Whatever option you choose, you'll still get the full compose panel and all the instruments.



mailto:support@swarsystems.com
mailto:support@swarsystems.com
mailto:sales-india@swarsystems.com

How do I install SwarShala
on Mac?

SwarShala

Installation

Extract the components of SwarShalaSetup.sit (.zip) file (users having a packaged version of SwarShala can find
SwarShalaSetup.sit (.zip) file on the SwarShala installation CD) in a folder or on Desktop. This will give you a
SwarShalaMacOSX installation CD icon.

Just note that from SwarShala 3.1 onwards, the downloaded file is a DMG (OS X volume) that opens and you'll find the setup
icon in there. For packaged versions, you'll have the setup icon directly at the root of the CD.

Double click on this icon to start the installation process. The installation process may take a few minutes.

After installation process is over, go to the newly created 'SwarShala' folder on your harddisk and double click on Unlock.app.
This will launch 'Unlock' screen where you should enter the Product Key received from Swar Systems.

Why do I need to register?

All

Registration

Your registration helps us in keeping you informed about the latest developments on Swar Systems’ front. This is specially
required from the users who buy the packaged version of the software from stores. Users who have downloaded it from the
site need not register since we already have them in our records.

Registration can be done by simply sending us the following information at registration@swarsystems.com

*  Your Name

*  Your Address

»  Products Purchased

e Serial Number of your package
e Product Key of your package

e Retailer information

How many installations
are allowed with a copy of
SwarShala?

SwarShala

Activation

SwarShala can be installed on two machines, provided they are for your personal use, through a single license code. In case
you need more installations, you can always contact us by sending a mail to support@swarsystems.com.

I recently bought a
SwarShala package from a
store. How do I get the
unlock code for SwarShala
and where do I enter it?

SwarShala

Activation

Windows

First, you'll have to register your copy of SwarShala. For this, please send your registration details to
support@swarsystems.com. Details should include:

- Your full name

- Address

- Serial Number and Product Key of the package.
- Retailer from whom you purchased the software.
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After you are registered, we'll send you a License code using which you'll be able to immediately unlock SwarShala online.

If your machine is connected to Internet, just launch SwarShala, enter the License code in the License Manager screen
and click on Activate. SwarShala should then be immediately activated.

If your machine is not connected to Internet, just launch SwarShala, choose ‘Phone/Email’ method from the License
Manager screen, note down the 12 digits Installation ID that’s displayed there. Then go to some other machine where you
have access to Internet, log on to www.internetactivation.com, enter the License code and the Installation ID and generate
an unlock code for your machine. You can enter this unlock code in Phone/Email screen of the License Manager. This will
unlock SwarShala.

Note: SwarShala works in full mode for 14 days after installation. This should leave you sufficient time to activate it. Once
this delay is over SwarShala won't launch anymore, but you can still activate it through the License Manager program. For
this, go to your Swar Systems folder, open the License Manager.exe file and follow the instructions mentioned above.

Mac

Mac clients can use the Product Key that comes with SwarShala for the activation. At the end of the installation, you'll be
asked to enter this Product Key. Make sure you type it exactly as it is: upper-case, no spaces. This will unlock SwarShala
once and for all. You can also activate the software by manually running the Unlock.app file available in your ‘SwarShala’
folder on the hard disk.

While installing/running SwarsShala Activation | This happens sometimes when the security of your Windows operating system prevents services from installing. You can
SwarShala I am getting a easily solve the problem by right-clicking on the License Manager program (within Program Files/Swar Systems folder),
Windows Service error. selecting Run as Administrator and then closing that program. You should then be able to run SwarShala normally.
What to do in this case?

When I open SwarShala it SwarShala Activation For Mac Users

says: Authorization failed.
It opens in demo mode
and I don't know where to
put a serial number?

Go to your SwarShala folder on your hard disk, open the Unlock.app file and enter the exact Product Key (upper case, no
spaces) that came with the package or which was sent to your by email and click on OK. This should unlock SwarShala.

For Windows Users

Go to your Swar Systems folder and launch the License Manager program. You can then put your License code in the
provided field (if you don't have a License code yet, contact sales@swarsystems.com for it).

If you are connected to Internet, the software will be immediately unlocked once you click on ‘Activate’.

If you are not connected to the web, select phone/email option and note down the 12 digit Installation ID that’s displayed
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there. Now go to a machine where you have Internet access, then log on to www.internetactivation.com, enter your License
code and Installation ID and generate an unlock code for your machine. Once you have that go back to your original
computer, launch License Manager, go to ‘phone/email’ page and enter the unlock code you generated. This should unlock
SwarShala once and for all.

I am not able to run SwarShala Activation If your computer ID is 10 digit that means you are using and old version of SwarShala. You need to first update your
SwarShala on my new PC. software. Go to www.swarsystems.com/Updates/ page and download the latest update. We'll then send you a License
My computer ID is 10 Number using which you'll be able to unlock SwarShala.
digit. What should I do to
install it on my new May be you are not a registered SwarShala user. If you have purchased the software from some store, kindly send your
computer? registration details to registration@swarsystems.com, then only will you be able to download all the updates.
I am using SwarShala. SwarShala Activation For Windows Users
Recently I changed my
computer. How do I get a You can generate an unlock code at www.internetactivation.com. You'll need to enter the License code that you have received
new unlock code for my earlier and your new computer’s Installation ID. You can see your computer’s Installation ID in the License Manager program,
new computer? Phone/Email screen. You can launch the License Manager from within your Swar Systems file. Just note that if your new
computer has Internet access, you can simply enter the License code in the Internet Activation screen of the License
Manager.
For Mac Users
Mac users don't need any unlock code. You can use the Product Key that came with the package for unlocking SwarShala.
Make sure you type it in upper case and without any space.
If you face any problems you can always contact us at support@swarsystems.com
I purchased SwarPlug Activation You can unlock SwarPlug and SwarTrax using the Product Keys that come with the package or that were sent to you through
SwarTrax/SwarPlug along SwarTrax email. You don't need anything else.
with the Product Key. Is
there anything else I need
to unlock SwarTrax and
SwarPlug?
SwarShala is not SwarShala Executing This may be happening due to some corrupted SwarShala files. Uninstall SwarShala, manually delete Swar Systems folder for

launching. When I try to
launch it, it stops at
“Loading Global
Components” then just
quits the loading process.

removing any trace of SwarShala files. Re-install SwarShala. This should solve the problem. Before you uninstall SwarShala,
do remember to take a back up of your bases folder. After you have done a fresh installation you can use your old bases
again. That way, you'll get all your patterns and sequences you created in your old bases.

Just note that before doing that, you may make sure you are running the latest version of SwarShala. From version 3.1.1
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onwards, corrupted practice sessions and default composition do not prevent SwarShala from loading anymore.

When I try launching SwarShala Executing This error comes when the security components within SwarShala couldn't install properly due to extra security on the
SwarShala I get an error Windows (Vista mostly) platform. To solve the problem, you can right-click on the License Manager program (within your
“Unable to open Windows Swar Systems folder), select Run as Administrator option, and then close that program. You can then launch SwarShala
Services'. normally.

I don't hear anything in SwarShala Executing > In most of the cases this is due to absence of an appropriate DirectX engine on your machine. Unless you are running
Practice and Compose Windows XP (it's already included), download and install the latest version of the DirectX components from

section? I am on www.microsoft.com/directx. Make sure you select the right version for your operating system. There is also no harm in
Windows. installing it over an existing DirectX version.

» DirectX installation files are already included in the SwarShala installation CD. Users who have a packaged copy of the
software can look for DirectX components in SwarShala installation CD. Just refer to DirectX folders and choose the one
that is appropriate for your operating system.

If you are on Windows Vista and not able to hear anything in Practice and Compose sections, then its due to a known bug in

Windows Vista Service Pack 1. Due to this, users may experience audio related problems with applications that run on DirectX

platform, including SwarShala.

There are a few workarounds for this problem. Check out the “Are Swar Systems products compatible with Windows

Vista?"” Section.

I can't launch the Learn SwarShala Executing Learn section is a Flash presentation for which Flash player should be installed on your machine. You can download Flash
Section. What's the player from: http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=ShockwaveFlash
solution?

We have also included the Flash player components in the CD.

Changing "Default Sa" in SwarShala Executing Changing the "Default Sa" in preferences dialog box only affects Compose Pane. For making scale changes in practice pane,
preferences dialog box choose the required scale from the "Sa:" drop-down list in the part definition controls.

doesn't make any change

in practice pane tuning.

How do I tune my practice

session.

Can I have Hindi fonts in SwarShala Executing Yes. To change the font to Hindi, click on the Preferences button, select 'Devanagari' from Strokes drop-down list and click

sequence view of practice
pane?

OK. The changes will be reflected in Compose pane as well.



http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=ShockwaveFlash

SwarShala freezes while SwarShala Executing First of all completely uninstall the software and manually delete the Swar Systems folder from C:\Program Files and then

loading. What should I install it again. Before you uninstall SwarShala, do remember to take a back up of your bases folder. After you have done a

do? fresh installation you can use your old bases again. That way, you'll get all your patterns and sequences you created in your
old bases. If the problem persists kindly email us at support@swarsystems.com

I recently bought SwarShala Executing SwarShala runs on Java Platform. You need to upgrade/install the latest Java Runtime Environment (JRE). From SwarShala

SwarShala. When I launch 3.1.1 onwards, you will need Java 6 installed. The installer for this version contains an option, checked by default, to install

it I get 'main class not Java 6 update 14. If you face such a problem, you can launch the installer again and make sure that option is checked.

found' error. What do I

do? If you are running a 64 bits version of Windows, check the “I am running a 64 bits version of Windows and I get 'main class
not found' error when I launch SwarShala.” section.

I am running a 64 bits SwarShala Executing SwarShala runs on Java Platform. You need to upgrade/install the latest Java Runtime Environment (JRE). From SwarShala

version of Windows and I 3.1.1 onwards, you will need Java 6 installed. The installer for this version contains an option, checked by default, to install

get 'main class not found' Java 6 update 14, but that's for 32 bits systems. If you are running a 64 bits version of Windows, you'll need to download

error when I launch the 64 bits version of Java 6 directly from the J2SE site (http://java.sun.com/javase/downloads/?intcmp=1281). Select the

SwarShala. What do I do? JRE package, 64 bits.

After looping a section in SwarShala Executing Download the latest 3.1.1 update. We have corrected a lot of issues in this update, including this one.

compose window while it

is played, it overlaps last

cell of loop into the first

cell of the loop. In Wind

instruments the last cell

keeps playing even after

the loop is started again.

This is very irritating.

I recently installed SwarShala Executing There was a small problem with the older versions of SwarShala for Mac (3.1.0 and lower). Please go to

SwarShala updates. But
now when I run practice
section, it shuts down
after a few minutes with a
message saying
‘something wrong with
libshala.jnilib library.

www.swarsystems.com/Updates/ folder and download the latest version for Mac. This should solve the problem.
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I have exported a SwarShala Executing Looks like your exported file is corrupted. This can happen if you close the DOS (black) window before the sequence is
sequence as wave file completely exported. Try exporting again, and allow this DOS window to disappear by itself.
from SwarShala, but it's
not opening in any
software.
I unlocked SwarShala but SwarShala Executing | Check the “When I launch SwarShala, it opens with Winrar. What to do?” section.
when I try to open
SwarShala icon it takes
me right to the Shala.rar
file. Why is this
happening?
When I launch SwarShala, SwarShala Executing This is because your have Winrar installed on your computer, and that at installation time you have assigned to it the .jar
it opens with WinRar. Swar Librarian extension, which is a Java Archive file that should normally open with java (SwarShala being a Java-based application). To
What to do? restore the default setting, just follow these steps:
»  Open Windows Explorer
e Choose Tools->Folder Options from the top menu bar
»  Choose ‘File Type’ tab
«  From the list of registered file types choose JAR
*  Click on ‘Change’ button down below and choose Java™ Platform SE binary from the list of Programs available.
Remember, SwarShala is a Java-based program, so you won't find any .exe file for launching the software. It opens through
the Shala.jar file placed in your Swar Systems folder.
Important note: you can also solve this problem by installing the 3.1.1 update, where SwarShala is launched through a new
SwarShala.exe program.
I installed SwarPlug, but I SwarPlug Executing If you have already installed SwarPlug, go to your Swar Systems/Plugins folder. There you'll see SwarPlug.dll file and a
still can't see it in Cubase SwarPlugData folder. Copy both these items and paste them in your default vstplugins folder. Normally that should be
(Windows version) C:/Program Files/Steinberg/vstplugins, unless you have specified some other vstplugins folder in Cubase.
How do I download the All Updating For downloading the updates, you must be a registered user. If you haven't still registered your product, please send your

updates? My email
address is not accepted by
the site for downloading
the updates.

registration details to registration@swarsystems.com. After you are registered, you'll be able to download the updates.

If you had registered your product in the past and still your email address is not being accepted, then maybe we have a
different email address in our records. In that case, please send a request for updating our records with your latest email
address.




I bought All Updating The Upgrade cost depends upon the version you are currently using. Contact sales@swarsystems.com for a personal upgrade
SwarPlug/SwarShala few price.
years back. How can I
upgrade to the latest
version?
I bought All Updating Just contact us at sales@swarsystems.com. If you are a registered user you will get the Mac download instructions for free.
SwarPlug/SwarShala a few
years back. Now I want a
Mac version of the same?
How do I get the latest All Updating You can download the updates from our website at http://www.swarsystems.com/Updates/. For more information feel free to
update of contact us on support@swarsystems.com.
SwarPlug/SwarShala.
I bought SwarPlug Full All Updating You can order an upgrade directly from our online shop at www.swarsystems.com/shop/. If you are not sure which upgrade is
Edition sometime back. for you, you can also contact us directly at sales@swarsystems.com.
How can I upgrade to Xtra
Edition.
When I shifted to Mac, I All Updating No problem. You can contact us on support@swarsystems.com and we'll assist you with an appropriate upgrade option.
upgraded to Vol 3 (I had 1
& 2 for Windows.) Having
had problems on the Mac,
I did not upgrade to Vol 4
but rather upgraded to
Vol. 4 on XP. That leaves
me missing Vol 3 on XP.
I am not able to download All Updating This means you are not a registered user yet. Your registration helps us in keeping you informed about the latest
the updates from Swar developments on Swar Systems’ front. This is specially required from the users who buy the packaged version from
Systems website. When I stores/shops. Users who have downloaded it from the site need not register since we already have them in our records.
try to do that I am getting Registration can be done by simply sending us the following information at registration@swarsystems.com :
‘Registration not found’ Name, Address, Products Purchased, Serial Number of your package, Product Key of your package, Retailer
error. information.
After this registration you will be able to download the updates.
Are the future All Updating For Updates you don't need to pay anything you can simply update your software form our website or you can send a mail to
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upgrades/updates free?

support@swarsystems.com for instructions. For future upgrades (when we are adding new instruments or significant new
features) we only charge a very nominal amount.

I am using an old version SwarShala Updating If you are using an old version of SwarShala, go to http://www.swarsystems.com/Updates/ page. There you can see and

of SwarShala. How do I download the available updates.

download the latest

update? Note: For downloading SwarShala updates, you should be a registered user of an old version of SwarShala.

I have installed SwarShala SwarShala Updating It seems you didn't follow the update instructions properly. This can happen when you don't select the existing Swar Systems
updates, but now folder as destination for your upgrade, and then copy/replace the folders. In this process, the original images are lost. The
SwarShala is not working easiest solution for this problem is to contact us at support@swarsystems.com and we'll email you new download instructions
normally. I don't get to reinstall from scratch.

instruments pictures in

Practice Panel and buttons

in Compose Panel. Can't

do anything. Whats the

solution?

I am using SwarShala Full SwarShala Updating You can pay the upgrade price and get the complete Xtra edition. Contact us at sales@swarsystems.com. We'll then prepare a
Edition for Mac and want special order for you for upgrade to SwarShala Xtra Edition. You'll have to pay $40 for the upgrade to SwarShala Xtra Edition
to upgrade it to SwarShala download version. If you want a packaged version, you'll have to pay additional $25 towards packaging and shipping.

3.1 Xtra Edition with all 74

instruments. How do I do Indian customers can directly contact us at sales-india@swarsystems.com

it?

I just installed the Volume SwarShala Updating May be you need the latest version of Java Runtime Environment (JRE). Download the latest JRE (JRE 6 or later) from

4 upgrade on my system http://java.sun.com/javase/downloads/index.jsp. This should solve the problem.

as per the download

instructions. Now If the problem persists, then probably the update was not installed properly. Contact us at support@swarsystems.com. We'll
SwarShala won't start. then send you the latest SwarShala Xtra Edition instructions, which will be easier than applying the upgrades.

When I click on the icon,

nothing happens.

I bought SwarShala SwarShala Updating You can directly email us at support@swarsystems.com for fresh download instructions.

download version
sometime back. Recently
my computer crashed and
now I am trying to
download SwarShala
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again. How can I get the
new download instructions
as the old download
instructions and links are
no longer working.

I have SwarPlug with SwarPlug Updating You can place an order for the upgrade at our online shop. In case, you face any difficult you can always contact us.
three updates Volume-

1,2,3. How can I get

Volume 4 for SwarPlug?

I recently updated to Swar Librarian Updating It seems you have an old version of Swar Librarian. You can download the latest version of Swar Librarian (v. 1.4.3) from

SwarShala 3.1. But now
Swar Librarian is not
working. How can I copy
the sequences from Swar
Librarian. What can I do
now?

www.swarsytems.com/Updates page. With this latest version you can simply drag the sequences directly into your sequencer
or any folder in form of MIDI files.




